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1. FR Y-14 XML Data Submission Overview 
This section outlines technical instructions for submitting FR Y-14 data. This document covers 
the file format and other technical specifications. This document is meant to supplement the 
Capital Assessments and Stress Testing information collection (Reporting Form FR Y-14) 
Instructions. Often, submissions that do not comply with the technical instructions cannot be 
loaded into the system and will require a resubmission. 

 

1.1. File Format 
Respondents must submit FR Y-14A data in Extensible Markup Language (XML). Extensible 
Markup Language (XML) is a markup language that defines a set of rules for encoding 
documents in a common format that can be shared in a consistent way. 

 
An accompanying XML Schema Definition (XSD) describes the elements of XML submission. An 
XML Schema Definition (XSD) describes a set of rules to which an XML document must 
conform in order to be considered valid according to that schema. XSD describes the structure 
of an XML document. 

 
The XSD items are defined in string format to allow for data types beyond those defined in the 
data dictionary. This is done to prevent restricting data types in the submission process. The 
data submitted should still comply with the data formats provided in the data dictionaries 
that are distributed with the technical instructions. Any data elements that do not comply 
with the Field Type and Attributes may need to be revised. 

 
Master XSD provided should be used for all current and historic submissions.  Institutions 

should only populate the data items that are applicable for the report form instructions from 

the as-of date.  For example, if the institution is submitting data historically for 2014 Q3 

during the 2015 Q1 processing period, the institution should use the 2014 Q3 report form 

instructions in conjunction with the 2015 Q1 version of the XSD. 

Master XSDs contain all data collection items for a given schedule since the transition to The 

Federal Reserve Statistics Function, including ended items. Institutions should use these XSDs 

going forward for all current and historic submissions. Institutions should only populate the 

data items that are applicable for the report form instructions from the as-of date. Any non-

applicable items for a specific as-of date should be left null. 

For schedules submitted through Reporting Central: Data files submitted through Reporting 

Central will be subject to additional upfront validations that were not run when submitting data 

files through Intralinks. Specifically, the following instructions should be followed: 

1. UTF-8 is the preferred encoding for .xml files. Files should not be submitted with a Byte 

Order Mark (BOM), and will be rejected by upfront validations if a BOM is detected.  

2. Data files will be subject to a complete validation against the relevant schedule’s XSD. 

Unless otherwise specified, any .xml file that does not conform to the XSD will be 

rejected. This includes the proper sequencing of parent tags and the inclusion of the 

DATA_ASOF_TSTMP attribute.  
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1.2. File Header 
XML file headers must include DATA_ASOF_TSTMP while LAST_ASOF_TSTMP is optional. 
Please see Appendix B: XML Validation for additional information. 

 

1.3. Primary Keys 
Primary keys are required to distinguish records as unique. Primary keys can be determined for 
each schedule by referring to the data dictionary. Primary keys are non-nullable fields and 
must be completed. We recommend that if an institution does not have data to report on a 
specified table, these items are left out of the submission rather than reporting “N/A” for 
primary keys. In the data dictionary, these fields are determined with “Yes” values in the 
“Primary Key” column. The data dictionary lists the format the primary keys must be in for files 
to successfully load. Common primary keys across schedules include: 

 ID_RSSD 

 D_DT (With the exception of Retail which has Reporting Month instead) 

 TRANSTYPE 
 

ID_RSSD must be the unique identifying number assigned by the Federal Reserve. 
 

D_DT and DATA_ASOF_TSTMP must be provided in "Date_Time” format ‘YYYY-MM-
DDThh:mm:ss’ or ‘YYYY-MM-DDThh:mm:ss.mmm’ 

 YYYY represents the year 

 MM represents the month 

 DD represents the last day of the reporting month 

 T represents the start of the required time section 

 hh represents the hour 

 mm represents the minute 

 ss represents the second 

 mmm represents the millisecond 
 

For example, the June 2013 reporting period would be represented 
as ‘2013-06-30T00:00:00’ or ‘2013-06-30T00:00:00.000’.  Note, the 
time portion of the D_DT must be all zeros while DATA_ASOF_TSTMP 
can be a value other than 0 such as TXX:XX:XX or TXX:XX:XX.XXX 
where the X indicates a value other than 0. 
There cannot be multiple D_DTs in a single submission. A file will fail to load if there is more than 
one D_DT in a given file. 

 
 

TRANSTYPE must be provided in one of three ways; I, U, or D. See Appendix A: Transtype Details 
for additional information. 

 “I” indicates an insert of a new data record. 

 “U” indicates an update to an existing data record. 

 “D” indicates a delete to an existing data record. 

 

1.4. Data Elements 
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DATA_ASOF_TSTMP should be provided in date time format ‘‘YYYY-MM-DDThh:mm:ss’ 
or ‘YYYY-MM-DDThh:mm:ss.mmm’, which is provided above. (This format also applies to 
LAST_ASOF_TSTMP, which is an optional attribute.) 

Each schedule has an XSD that contains all data elements collected since being processed 
through the Federal Reserve’s Statistics function. Respondents can utilize the most recent 
XSD for both historical and current submissions and submit applicable data items per the 
instructions of the submission date using the FR Y-14 instructions of the respective as of 
date. 

Items should be reported as 0 instead of 0.000000.  If an item is not applicable to your 
submission the field should be left null. 

The Summary schedule requires a full file submission with each mandatory scenario. Each 
projection period (PQ1, PQ2, PQ3, PQ4, PQ5, PQ6, PQ7, PQ8, PQ9, (PQ10+ if needed)) is 
required for each unique scenario (CCARP006).  
 

Items applicable to the entire projection horizon, such as those on the Trading and Counterparty 
worksheets, should only be populated for PQ1 and the values should be for the entire projection 
period. 

 

1.5. Submission Type 
Beginning with the 2019Q2 FR Y-14A submissions, there is a new required primary key item, 

Submission Type, for all sub-schedules in the following schedules: 

 Schedule A - Summary 

 Schedule B - Scenario  

 Schedule F - BPC 

 

A standard Q4 submission with data as-of 12/31 should be labeled “Original” and a standard Q2 
submission with data as-of 06/30 should be labeled “Mid-Cycle”. Other labels should only be 
used if requested. 

 

1.6. Submission 
Firms will submit Y-14A XML files through Reporting Central.  For information on how to submit 
data through Reporting Central, please reference the Reporting Central User Guide.  

 

If two files need to be loaded in a certain order, we recommend that the file that needs to be 
loaded first is uploaded to Reporting Central at least 30 minutes before the second file is 
submitted. 

 

See the Reporting Central User Guide for more information on how files should be uploaded. 

 

 
1.7. File Name 
The Intralinks Technical Instructions or the Reporting Central User Guide (as appropriate) should 
be used for XML file naming guidance. 
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Firms can optionally use the following naming convention for their xml data files: 
FRY14Q/A_YYYYQQ_Schedule_IDRSSD_CreationDate(YYYYMMDD).xml 

 

 

1.8. Common File Load Issues 
 Incorrectly formatted record headers. 

 Not using the most recent XSD provided. 

 Incorrect transtype provided. 

 DateTime fields incorrectly formatted. 

 Null or missing primary keys. 

 Duplicate records with identical primary keys. 

 Incorrect ID_RSSD. 

 Incorrect D_DT. 

 

1.9. Version Conventions 
The technical instructions are published with a naming convention designed to identify changes 
between publications. The file names contain the version number. In addition, the header of 
each document contains the Collection Period and the version number. If technical instructions 
are republished within a quarter, only the documents that were modified will be updated from 
a “V1” to a “V2”. All documents that were not modified in the republication will remain “V1”. 

 Examples: 
o File name for the first version of published technical instructions will end in: 

 “_V1” 
o File name for the second version of published technical instructions for a document 

that has been modified will end in: 
 “_V2” 

 
 
 

2. FR Y-14 Respondent Edit Report Overview1 
This section outlines technical instructions for how to provide FR Y-14 Respondent Edit Reports. The 
document covers the file format and other technical specifications. This document is intended to 
supplement the Reporting Central technical guidance. Often, submissions that do not comply with the 
technical instructions cannot be loaded into the system and will require a resubmission. 

2.1. File Format 
Respondents must submit each Respondent Edit Report via comma separated value (.CSV). When 
applicable, a Statistics Reserve Bank contact will send a password protected Respondent Edit Report 
in Excel (.xls/.xlsx) format. Respondents must enter responses and save the file as a CSV. To do this, 
select File > Save As > Save as Type and select “CSV (Comma delimited)” from the drop down menu. 

 

Files should use LF or CR/LF as a row delimiter. Respondent Edit Reports using just CR as a row 
delimiter will not be loaded.  

                                                            
1 In the past, certain firms have chosen to provide supplemental information in connection with their submissions. An 
example of such a supplement is available in the provided technical instructions. If a respondent elects to provide 
supplemental information in connection with its submission, it may provide any information in any form that it 
chooses. The Board is not requesting that respondents submit supplemental information. 
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2.2. File Header 
The first line of the file should have a column header containing the column names, which must be 
separated by commas. Columns in the file must adhere to a specific predefined order outlined in the 
respondent edit report templates provided by the Reserve Banks. 

 

2.3. Primary Keys 
When you first open the password-protected Excel file, all primary key fields should be already 
formatted to “Text”. If you enter your responses all at one time and save the file in a CSV format, 
you will preserve the formatting for the proper fields. Preserving the format is critical to submitting 
a successful edit report that will load into our database. 

 

2.4. Common File Load Issues 
If you intend to revise remarks several times before a submission, we recommend that conversion to 
CSV be done as the final step. Opening and resaving a CSV can undo previously set formatting which 
results in errors which will prevent the loading of those records to our database and require a 
resubmission. For example, the loss of leading zeroes or inadvertent scientific notation formatting. 
CSV files that contain line feeds or carriage returns in any column will also prevent the loading of 
remarks to the database and require a resubmission. 

 
The proper format of the As-of date field is ‘YYYY-MM-DD hh:mm:ss.mmm’. Note: The time stamp 
values must all be zeroes. 

 

2.5. Submission 
Firms will submit CSV remarks files through Reporting Central. For information on how to submit 
data through Reporting Central, please reference the Reporting Central User Guide.  

 

2.6. Naming Conventions 
The CSV file should adhere to the following naming convention. 

 

FRY14A/Q_YYYYQQ_Schedule_IDRSSD_RespondentEditReport_CreationDate(YYY 
YMMDD)_NumberOfEditFailures.csv 

 

 

3. FR Y-14 Edit Documentation 
A list of all edit checks are provided in the edit documentation. To determine the changes for the 

current quarter filter by edit declared final date to see the red-line changes. 

3.1. Version 

Indicates the version for a given Edit Number. A new version is created when logic is 
revised, however if a change does not affect the logic then a new version is not created. 
Possible values include 1, 2, 3, etc. 

 Edits in place for 20140930 will become Version “1” 
 Any changes made for subsequent quarters will be prior Version number “+1” 
 We will only version going forward (no previous versioning will be considered) 
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3.2. Edits and Data Dictionary Status 

Indicates the status of a given edit and data dictionary item. 
 Deleted 

o The edit or data dictionary item will no longer be applied in any form for 
current or historic data. Once a status has been changed to "Deleted" it 
is permanent. 

  “Deleted” for edits that will no longer be applied in any form 
 No Change 

o The Edit or data dictionary item has not changed since the previous quarter. 
 Added 

o The Edit Number or data dictionary item is new since the previous quarter. 
 “Added” for edits and items that are completely new 

 Archived 
o The Edit Number remains the same, but the Version number is retired (does 

not change quarter over quarter), or the data dictionary item has ended. 
Once an item has been 'Archived" the status is permanent. 

 Revised 
o The Edit Number remains the same, but the Version number may be new since the 

previous quarter if a logic change is made to the edit, or the data dictionary item 
has been updated. 

 “Revised” for edits that are a new version of an existing edit 

3.3. Edit Type 

Indicates the type of edit check run on each data element. 

 Syntax 
o Address the data type and are designed to ensure data is in the correct 

format. Institutions must correct these edit failures. The start and end dates 
for active Syntax edits are always 19000101 and 99991231 respectively. 

 Will utilize the following formats: Numeric(digits,dec) and Varchar(#); 
Integer data type edits will no longer be used 

 Indicate that the field must be numeric and specifies the number of 
digits and decimals permitted 

 Ex: 
Edit Error Message - Must be numeric & must be 
Numeric(16,6) 
Edit Logic - Must be Numeric(16,6) or for ID_RSSD, use “Must 
be Numeric(7,0)” 

 Validity 
 

o Address the data accuracy and include mathematical calculations, factual 
consistencies, and relational calculations that must pass the edit. Depending 
on instructions, business conditions, and requirements, the condition must 
be true. 

 Ex: 
Edit Error Message - If provided, FIELD1 must be greater than 
or equal to 0 
Edit Logic - If <> NULL, FIELD1 >= 0 
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o In some instances you will see validity edits that say must not be null, review 
these items and update if optimal, in instances where a null is the optimal 
field provide an edit explanation instead of a revision. 

 Quality 
o Addresses data accuracy but measures the reasonableness of the data that 

should pass the edit. There are valid conditions in which correctly reported 
data could trigger an edit resulting in a false positive. The edit responses 
provided for these false positive edits provide valuable information to the 
data end users at the Federal Reserve. 

 Ex: 
Edit Error Message - If provided, FIELD1 (Current Quarter) 
should be greater than or equal to FIELD2 (Previous Quarter) 
Edit Logic - If <> NULL, FIELD1 >= FIELD2 

o Intraseries 
 Type of quality edits designed to monitor unusual or unexpected 

changes between report periods. 

o Interseries 
 Type of quality edits designed to monitor unusual or unexpected 

reported values between different report series. 

 
3.4. Quarter Modified Date 
Quarter modified date will be the collection quarter the edit was last modified. 

 To determine the changes for the current quarter filter by the quarter modified date to see 
the redlines of what changed. 

 If any changes occur after the edits are initially sent to the institutions, the date would be 
updated to reflect the most up to date changes. To see the applicable edits for a given 
quarter, the Status and/or Start and End Date columns can be used as filters. The quarter 
modified date is updated for all redline changes. 

 
 

3.5. Start Date 
The start date is the date the edit will be effective. For technical reasons this may not always match 
the date the edit waslast modified. 

 Ex: 20070331 
 

3.6. End Date 
The last effective quarter the edit would run. For technical reasons this may not always match the 
date the edit was last modified. 

 Ex: 20130930 or 99991231 if the edit is currently running on the data. 
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Appendix A: Transtype Details 
Transtype is utilized to insert (I), update (U), or delete (D) records. Each record submitted is uniquely 
identified by its primary keys and must be marked with a Transtype value. These markers indicate what 
action should be taken to systematically upload data to the database. Correct use of these markers are 
important for successfully loading data. 

 “I” should be used to insert records with a unique set of primary keys that does not already exist 
in the database. 

 “U” should be used to update records with a unique set of primary keys that already exist in the 
database. The “U” Transtype updates the entire record, therefore, even if one data item 
changed, all other items must remain in the record for the record to be updated successfully. 
Not including unchanged data items in the records will NULL out those columns.    

o If a Transtype “U” record is included for a set of primary keys that do not exist in the 
database, a file load failure will occur. 

 “D” should be used to remove records with a unique set of primary keys that already exist in the 
database. 

 
Submissions may contain combinations of Transtype “I”, “U”, and “D” for different records. However, a 

submitted file cannot contain different Transtypes for records that contain the same set of primary keys. 

 

Submissions of Transtype of “U” or updates are encouraged when possible rather than a delete (“D”) 

and subsequent insert (“I”). In the circumstances when a primary key needs to be changed, Transtype 

“D” must be used to remove the incorrect set of primary keys before inserting the new record (“I” in a 

subsequent file). 

Partial data files are acceptable for the following schedules: 
 

 Scenario  

 Operational Risk (Y-14A) 

Full data files are necessary for the following schedules: 
 

 Business Plan Change 

 Summary 

 Regulatory Capital Instruments (Y-14A) 

 

Initial Data Submissions 
The first submission of a reporting period should include all new records, and therefore Transtype 
indicators of “I” for each unique set of primary keys are expected. 

 

Submissions that Fail to Load/File Load Issues 
If an initial submission failed to load (i.e. no records loaded to database) a revised submission should 
utilize a Transtype “I” for all records (each unique set of primary keys). 

 

Revised Submissions 
If an additional record with a unique set of primary keys is to be added after an initial submission, the 
record should use Transtype “I”. 
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Any resubmission with a change to a data value from a previously provided value that was successfully 
loaded should use Transtype “U”. 
 
Transtype “D” can be used to remove a previously submitted record from the database. 
 

In most instances, it is recommended to utilize a Transtype of “U” to modify data values already in the 

database. However, in order to change a primary key Transtype “U” cannot be used instead Transtype 

“D” is used when there is a syntax edit failure on a primary key. In these scenarios a Transtype “D” 

should be used to remove the incorrect set of primary keys before inserting the new record of 

Transtype “I”. 
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Appendix B: XML Validation 
XML validation is the process of checking a document written in XML to confirm that it is both well 
formed and valid. A well formed document follows the basic syntactic rules of XML, which are the same 
for all XML documents.  A valid document respects the rules dictated by the XSD. 

 
There are various free tools available that will validate XML documents against given XSDs. 

 XML Notepad 2007 (http://www.microsoft.com/en-us/download/details.aspx?id=7973) 
provides a simple intuitive user interface for browsing and editing XML documents. 

 Notepad++ (http://notepad-plus-plus.org/) plugin that offers XML validation against an XSD. 

 Xerces C++ (http://xerces.apache.org/xerces-c/) is a validating XML parser written in a 
portable  subset of C++. Xerces C++ makes it easy to read and write XML data. 

 
Microsoft Excel offers a built in function to validate XML data against an XSD to ensure that any XML 
data you import to or export from one or more cells in a mapped range in a worksheet conforms to 
the XSD in the XML Source task pane. 

Excel XML Validation 
1. On the Developer menu, point to XML, and then click XML Map Properties to display. 
2. In the XML Map Properties dialog box, select Validate data against schema for import and 

export. 
 

Please see the screenshot below for an example of a graphic display of how to validate and 
export an XML file. 

 
 

XML File Creation 
The following examples provide instructions on how to create an XML file that contain multiple 

tables. The example provided demonstrates how to properly map an FR Y-14A Summary file but it 

can be replicated to map any of the multiple table files collected in the FR Y-14A schedules. 
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Example: Multiple Table XML 
The following process is an example of how an XML file can be created. Details for the reported 

values and the MDRM’s can be found in the accompanying data dictionary documentation. This 

documentation will identify the reported value and further prescribe the data type and format that 

is expected for the reported values. To map an .xsd follow the steps below using 

SMRY_Version03.xsd as an example: 

1. Save the SMRY_Version03.xsd to a local drive that can easily be accessed. 
2. Open a new Excel document, select the ‘Developer’ tab in the toolbar at the top, and locate 

the ‘Source’ icon. Once selected a pane on the right most portion of the screen will appear. 
Select ‘XMLMaps...’ from the bottom of the pane and then select ‘Add…’ from the pop-up 
screen. 

 

 

 
 
 
 

3. Next locate and select the SMRY_Version03.xsd and click open. The ‘Multiple Roots’ dialog box 
will appear. Select the SMRY_Data_Collect option and then click ‘OK’ 
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4. Then select ‘OK’ on the ‘XML Maps’ dialog box. After selecting ‘OK’, the data elements will 
populate in the right hand pane. We will map each of the tables to a separate tab. For 
reference, label nine tabs according to the nine sets of data being collected. 

 

 

 
 
 
 

5. First map the DATA_ASOF_TSTMP and LAST_ASOF_TSTMP tags. While pressing the ‘CTRL’ key 
select those two items with the mouse then click and drag the cursor to cell A1. Cells A1 and 
B1 will then be highlighted indicating successful mapping of these two items. 
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9. Save the SMRY_Version03.xsd to a local drive that can easily be accessed. 
 
 

Notes: 
 

 Excel changes date formats into Julian Date; to ensure the date is in the correct format listed 
in the technical instructions all date fields should be formatted as text. 

 If a schedule has multiple tables and an institution does not have data for one of the tables 
do not provide any values for the primary keys. 

 These instructions work for the current excel version of Office 2013 as of September 30, 
2014. Any software updates to Microsoft could alter these instructions. 


